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Wishing Keith Vaughan a big get well 
and hope you are feeling much better 
soon.

Norma and Milton Gregg, Long time 
valuable members of the PGNS who 
are no longer able to come to the 
guild.  For those of us who know 
them, we miss you Norma and Gregg.

Best Wishes to Jen Fried, our Past 
President, who has had a long illness.  
So glad you are feeling better Jen.

WELCOME TO NEW MEMBERS 
2009 - 2010 TO THE PHOTOGRAPHIC GUILD 

OF NOVA SCOTIA

Vadim Belakov
Alain Cacchione
Natalia Castellanos
Stephan Davidson
Camillo Di Quinzio
Richard Dunlap
Cathy Northrup
Eric Rushton
Chris Sheppard
Dennis Stewart
Rocky Yao
Kate Browning
Ewa Dunlap

Tony Egan
Jim Marshall
Joanne McCarthy
Janice Mitchell
Joanna Nimeck
Patti Ellis
Vicki Gaul
Gary Gaul
Mona Ghiz
David Hachey
Elizabeth Glass
Justine MacDonald
Elaine Marshall
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 The Christmas and New Year holidays and 
celebrations are over and yes the weather has 
been for the most part gloomy and dreary.  So 
what do we do photographically this time of year 
besides the Christmas Lights that most of us 
probably didn’t photograph because there with no 
snow to spark them up.
 Well as Ansel Adams says, you don’t take a 
photograph you make it so let’s look for a few 
ideas of making photographs to get us through this 
dreary part of the winter.
 The first thing that comes to mind is, after 
hearing some members didn’t want to photograph 
birds because it is too hard.  Well here’s one way 
we can make a photograph.  Instead of running 
around in fields, woods, trying to find a bird to 
photograph and usually missing it as it flies off so 
fast, try bringing the birds to you.  Here is how I 
do it.  I get a 2x 4 15 foot post, pound it in the 
ground, put a platform on top, drill holes in the 
platform and stick small branches, tree sticks, etc. 
in and fill the platform with delicious food for the 
birds.  Make sure there is only one high perch as 
birds usually like to land on something  higher and 
look around before they land on the platform. Set 
up your camera on a tripod, shoot from an open 
window if you can manage it and stay warm.  
Don’t shoot through glass as one usually needs to 
use flash to highlight the bird’s eye and the 
reflection spoils the picture.  
 If you are needing Creative images, how 
about buying some food dyes, or paint and run it 
down a piece of glass and photograph the different 
shapes that take place.  Or, simply draw a pattern 
of circles, lines, and/.or triangles on the glass and 
then photograph it.  
 Also this is a good time to do some 
multiple images in Photoshop.  Please see Stephen 

Patterson’s article on Page 26  as he gives a very 
detailed way of doing these multiple images.  
Working with slides! Throw a bunch out on the 
light table and try them together.  You will be 
surprised what you will come up with. Take them 
out of the plastic slide mount and put them 
together into one new mount.
 John Wm. Webb is leading field trips to 
photograph Eagles in the valley. We all know 
where the eagles are so it is just a matter of time 
sometimes waiting for them to be fed and shoot 
away.  Please see the PGNS Website for details on 
the Eagle trips.  www.photoguild.ns.ca
 Yes, you can shoot flowers now.  Buy a 
bunch that look like likely good close up shots.  
Put them in the window and back light them from 
window light, or shine a light behind them if the 
sun doesn’t come out. Remember to overexpose.
 We can also buy some artificial flowers and 
stick them in a small tank, gluing or taping them to 
the bottom of the tank.  Pour in some 7-up or 
other clear bubbly stuff and watch what happens.
 Watch what other photographers do and 
learn from them, including their mistakes.  An old 
Chinese Proverb says: “Learn from the mistakes of 
others, because you won’t have time to make 
them all yourself.  Be interested in other people’s 
work and learn.

“YOU DON’T TAKE A 
PHOTOGRAPH YOU MAKE IT.”  

- Ansel Adams

Editor’s Page

By Etta ParkerPhoto: John Wm. Webb

Photos: Etta M. Parker
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PRESIDENT’S 
PAGE

I hope everyone had a great holiday season! 

 It is hard to believe 2009 is gone and we 
are well into our 2009- 10 Program.

 Just a few of the events so far this year 
that come to mind:  

 Our Dig i t a l Pho tog raphy Bas ic s 
Workshop in September was well attended and 
well received. I would like to thank Peter Steeper 
for organizing this first rate event; the two main 
presenters Mike McCarthy and Steve Kaiser as 
well as John Wm Webb and Mervyn Kumar-Misir 
who assisted Peter, Mike and Steve with the 
afternoon modules of the Workshop.

 Laszlo Podor did an excellent job in 
organizing our Fall Show in November. My 
thanks to him as well as Hubert Boudreau, Joyce 
Chew, Teunis Obdam, Carolyne and Ken Renton, 
and John Wm Webb for their efforts in putting 
the show on. Presentations from Joyce Chew, 
Eugene Mio, Stephen Scott Paterson, Keith 
Vaughan and John Wm Webb, combined with 
our best Guild member images and silent image 
presentations for a great show.  

 Our Christmas Party at Ashburn was an 
enjoyable evening and reasonably well attended 
despite the inclement weather. Thanks to Edie 
Greene for organizing the event and to Wally 
Hayes for his great presentation, which included 
some of his son’s creative images offering a 
complimentary change of pace to Wally’s stellar 
photo travel images.

 I would like to welcome all new 
members at the Guild. I hope you are enjoying 
our Program and encourage you to contact any 

member of our Executive if you have any 
comments or questions as you “get your feet 
wet” in Guild activities.  

 Northwood is building a new care facility 
on Hammonds Plain Road and one of our 
members, Charlie Plant, is assisting them with 
acquiring photographs to help decorate the new 
home. Particulars on the type of photographs 
being sought and other requirements have been 
circulated previously,  These also will be 
available at Guild meetings in January. The 
deadline for submitting up to five photographs is 
February 1st, 2010. If you have any questions, 
C h a r l i e c a n b e c o n t a c t e d a t 
charlesplant@eastlink.ca . I encourage you to 
consider donating some photos to this 
worthwhile endeavor. By the way, hard copy 
images for this cause can be brought in to our 
January 31st Guild meeting.

 I hope you reach all your 2010 
photography goals and have a lot of fun doing 
so!

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca
mailto:charlesplant@eastlink.ca
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The first half of the program focused on Atlantic Canada and the shows covered 
the majestic scenery and nature of the provinces of Newfoundland, Prince Edward Island and 
Nova Scotia. Five of our long time members presented in this part of the show as follows:

- Images close to Home  by Stephen Scott Patterson
- Flavours of PEI  by Keith Vaughan
- Kejimkujik: Backcountry Paradise  by Joyce S.K. Chew
- A Glimpse of Nova Scotia in All Its Seasons  by Eugene Mio
- An Adventure of Peace and Beauty, Newfoundland 2009  by John Wm. Webb

In the next part of the Fall Show, our guests could see the best Silent Essays. In the Silent Essay 
competition, entrants submit up to 12 images that develop a common theme, story or idea. These 
images are judged without any music or narrative. 

5th place:
 Main Course Water Rat                by Marian Boyer
4th places:
 CDN Track and Field Championship    by Keith Vaughan
 Greek Doors                          by Nancy Johnson
3rd places:
 Art Of The Female Form              by Mike McCarthy
 West Branch Bear River                        by Cliff Sanderson
 Faces Of China                       by Marg Nolen
 Flower Magic                         by Jen Fried
 Playing The Slots In Arizona         by Clive Elson
 What Your Dog Sees                   by Colin Campbell
2nd place:
 Water Colours                        by Carolyne Renton

After the best Silent Essays, the best images were shown from the members of the Photographic 
Guild of Nova Scotia. We said good bye to our guests with drawing 11 valuable door prizes at the 
end of our Fall Show. These door prizes were offered by our sponsors - Atlantic Photo Supply, 
Black's Photography, Carsand Mosher Photographic and Henry's. Thanks to our many volunteers, all 
presenters and all our members, we had a very successful Fall Show.

A SPECIAL THANK YOU TO LASLO PODOR WHO PUT TOGETHER AN 
EXCELLENT SHOWING OF THE GUILD’S WORK.  THANKS LASLO!

PHOTOGRAPHY 
GUILD OF NOVA SCOTIA 

FALL SHOW
November 21, 2009

Organized and Directed by Laslo Podor

Special thanks to 

Dean Hirtle, Joyce 
Chew, Obdam Teunis, 
Mervin Kumar-misir, 
Hubert Boudreau, Etta 
Parker, Barry Burgess, 
Ken Renton, Carolyne 
Renton, Stephen Scott 
Patterson, Eugene Mio, 
Keith Vaughan and John 
Wm. Webb.

http://www.photoguild.ns.ca
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CONGRATULATIONS TO ELIO DOLENTE

Elio was recently appointed Photojournalism (PJD) news Editor.  His first column appears in the 
January 2010 PSA Journal news on-line.  This edition will be available at:
http://www.psa-photo.org/news.asp?menuID=3&DivID=8

Elio has also been invited to judge the 2010 PSA International Newsletter Contest making this Elio’s 
third invitation as judge for this contest.

I would like to mention also that Elio was the Newsletter Editor for the Photographic Guild of Nova 
Scotia for three years and won the International Newsletter Contest three years in a row.

Great work Elio.  Congratulations again from all of us.

Love At First Sight by Bob Kerr

CORRECTION

This image titled “Love At First 
Sight” was inadvertently 
credited to Keith Vaughan in 
the May newsletter.  

The image credit belongs to 
Bob Kerr. My apologies Bob!

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca
http://www.psa-photo.org/news.asp?menuID=3&DivID=8
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PROSHOW  by 
Mervyn Kumar-Misir

Proshow is THE software used by a majority of 
photo clubs. There are other similar software. For 
example, Quicktime will produce a video to 
display and present your show if you are using a 
Mac. A video production program like Ulead or 
Adobe Premier will produce a DVD type movie 
playable on any consumer DVD player or on your 
computer.  However, the use of other software 
leads to a bit of a nightmare during judging of our 
Silent and Sound Essays.  Switching software 
players during the heat of judging is too time 
consuming and choppy– not to mention the lack of 
continuity at our Fall and Spring shows.

Proshow is relatively inexpensive and is 
downloadable from Photodex. You can download 
the trial version to experiment with; it is the full 
version of the software. However, the final output 
video will have a bar across the images. Once you 
decide to purchase, they will e-mail the ID.  The 
next time Proshow is booted, the ID will unlock the 
full potential of the software.  The disturbing black 
bar will now be history. Software updates and even 
new versions are available free for one year.  
Updates are not patches or fixes for what you 
already have. These completely new versions are 
downloadable and are installed afresh.

PHOTO SELECTION

The first task is to create a new folder. Place it in a 
unique spot – preferably on the desktop – where 
you can access it easily. Do not imbed it as a 
subfolder elsewhere.  Having it on the desktop will 
save you a lot of time and frustration as you make 
up the show.  You will be able to easily locate the 
folder.

Next, look through your image 
files for images that fit the theme. Place 
copies of these images into the new folder. 
You will need a good selection of images with 
which to work. Of course, many of these will be 
eliminated as you make up the show within the 
time and image number constraints.  If you have 
music files stored elsewhere on your hard drive, it 
is a good idea to copy the music files you’re going 
to use to this folder too.

ARRANGEMENT OF IMAGES

Open the folder and display the images. Choose 
the medium icon setting so you can see the images. 
They will be displayed large enough to be seen on 
the screen. Arranging the images in sequence to 
tell the story is the next job. Begin the process of 
renaming. It is easier just to use a number system.  
I recommend using every second number, i.e. 
001…003…005 etc. This will give you an 
opportunity to insert images in between later.  
ProShow will import them to the timeline in the 
same order that they were renamed 001…003…
005…etc. This will save you a lot of time and 
frustration since the images in the timeline will 
now be in the proper sequence.  If need be, you 
can still move the images around on the Proshow 
timeline but it is a bit of a pain since the visible 
part of the timeline is not very long.  Only 7 images 
will be displayed at any one time.

THE PROSHOW SCREEN

Once renaming is done, all the images are ready 
for inserting to ProShow. When ProShow is booted, 
you will notice several windows as shown in the 
picture below.

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca
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Let’s look at the ProShow display.  First, there are 
five sections or windows. The long top window 
displays a number of icons, and we will look at 
these later. At the very bottom is the timeline. This 
is where your images and sound files eventually 
end up. On the right is the preview window where 
the show is played as you work through on it. On 
the left are two smaller windows that are 
adjustable. The top one -  #1 - is where you look 
for your file folder where all your selected images 
are housed.  Clicking on this folder will load all 
the images of that folder to the bottom - #2 - 
window.

LOADING IMAGES TO PROSHOW

Sometimes it is really difficult to find your image 
folder in window #1. If you do find it all well and 
good – all images therein will appear in window 
#2.  To place all these images into the timeline, 
right click on any one of the images of window #2. 
A drop-down display will appear. You will see … 
ADD TO SHOW … this will add one image of the 
group to the timeline.  ADD ALL IMAGES TO 
SHOW will add all the images of window #2 to 
the timeline. This is the one you want to use - just 
click on it and wait. ProShow will place all the 
images into the timeline in the same order as you 
numbered them. This process will take some time 
depending on how many images you have in the 
show.

ANOTHER WAY TO LOAD IMAGES TO THE 
TIMELINE

Minimize the ProShow window to occupy ¾ of the 
screen area. Open the folder where your images 
are stored. Minimize this window to occupy the 
remaining ¼ screen area.  With these two 

windows in plain view, you simply drag the 
images to the timeline.  When all images are 
loaded, maximize the ProShow window to 
continue the work. When maximized, the 
ProShow window will appear as shown in the first 
image above.

SETTING IMAGE AND TRANSITION DISPLAY 
TIMES

Observe the timeline. Notice each image is set  to stay 
on for 3 seconds. The transition time (the small icon 
with “A” between each image displayed) is also set for 
3 seconds. These are the default time settings. 

According to the Blue Book, the display time allowed 
for each image is a maximum of 7 seconds. 

As an initial measure, it is a good idea to set all the 
images to 7 seconds and transitions to 1 second. To 
do this, right click on any of the timeline images 
whereupon a drop down window will appear. 

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca
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Click on SELECT ALL. All the Images and transition 
will now be highlighted.  Now click on the 3 on 
one of the images and type in a 7. Move to the 3 on 
one of the transitions and type in a 1. Now click 
anywhere outside the image or transition and all the 
images will change to 7, and all transitions will 
change to 1. In the actual show you may want to 
have images displayed at different times. Simply 
clicking on the 7 and typing in a different value will 
change that image time only. Follow the same 
procedure for the transitions.

C U S TO M A D J U S T M E N T O F 
INDIVIDUAL IMAGES

Although there are a number 
of icons at the very top of the 
ProShow screen, we will 
ignore these for the time 
being – there is an easier way 
to adjust each image.  Simply 
DOUBLE CLICK on the image 
with which you want to work 
and a new window will open 
up.  For now we will just deal 
with LAYERS, EFFECTS, and 
CAPTIONS.  So click on 
LAYERS – sliders will appear 
which will allow adjustments 
of BRIGHTNESS, WHITE 
POINT, etc. There is even a 
sharpening slider! Try all 
these to see what each will do 
for that image.

CLICK ON EFFECTS – two sub-windows will appear 
that allows you to zoom and/or rotate the image.  
Try them to become familiar with what they can do. 

CLICK ON CAPTIONS. You will see a CAPTION 
and PREVIEW window. In the CAPTIONS window, 
you can type in the text of your choice. 

The default font is set at ARIAL, but you can change 
this at will. The text will also appear over the image 
within a little window. You can hold down the 
CLICK on this window and move the text around 
placing it wherever you wish. There are also little 
square toggle points on the border of this little text 
window. These will allow you to adjust the text size.

TEXT EFFECTS is found in middle window to the 
left. Let’s look at FLY IN. Click on BROWSE and a 

drop-down window will appear. There are a large 
number of effects that control how the text enters 
the image frame. Find an effect you like. When 
done don’t forget to click on APPLY to set the effect.

When these 3 procedures (LAYERS, EFFECTS, and 
CAPTIONS) are done to your satisfaction, click on 
OK to set all these controls to that particular image. 
This working window will now close. You can 
check what this image will look like in the finished 
show. Just CLICK on the image to highlight it; then 
CLICK on the PLAY ICON in the PREVIEW window. 

If you want to delete one or more of these settings 
for that particular image, RIGHT CLICK 

on the image. A window will drop 
down. Go to REMOVE and take it 
from there.

TRANSITIONS

It is very easy to set up the 
transitions between the images. Just 
CLICK on the TRANSITION ICON 
(the small icon with “A” between 
the images). A large window will 
appear. Placing the cursor on any 
of these icons will show you what 
they would do in real time.  When 
you find the one that you like, just 
CLICK on i t and i t wil l be 
transferred to the transition (icon A) 

control between the images.

ADDING SOUNDS and/or MUSIC

There are 2 ways to add music to your show.

I am assuming you have already transferred pieces 
of music to the original ProShow folder which you 
made up for the images.  The procedure is exactly 
the same as outlined above to transfer images to the 
timeline.   Find and click on the music file, then 
drag  and drop them to the Audio section of the 
timeline.

You may have music on a CD that will augment the 
show.  Place your music CD in the CD/DVD drive. 
Click the MUSIC icon on the top of your ProShow 
screen.  This Icon looks like a speaker. A new 
window drops down. 

http://www.photoguild.ns.ca
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1. Click on the SAVE MUSIC FROM CD  (bottom 
left-hand corner).  A window will appear listing 
all the selections found on your CD. 

2. Click on the selection you wish to use for your 
show.  

3. Click SAVE TRACK. You will then tell ProShow 
where to save the track and this will be the same 
folder where all your images are housed.  

4.  In the next Window, click SAVE. Each music 
selection will be saved in your image folder. As 
the selection is being saved, ProShow will 
automatically place them onto the audio section 
of the timeline. 

5.  When finished Click on DONE. If your show is 
long and several different music selections are 
loaded, they will be separated by alternating 
colours (green, red, and blue).

H O W T O S Y N C H R O N I Z E S H O W T O 
SOUNDTRACK

In most cases the music selections on the sound 
track will be long and go beyond the last image.  
When this last image is shown the music continues 
for a second or two ending abruptly.  There is a way 
to fade out the music as the last image is shown.

Locate the music track just below and at the right of 
the last image.  RIGHT CLICK on the music track at 
that point.  At the window, click MANAGE 
SOUNDTRACK. In the Show Options window, 
click SYNC SLIDE TO AUDIO (bottom left-hand 
corner). In the Synchronize Show to Soundtrack 
window, click SYNC.  In the SHOW OPTIONS 
window, click DONE.

CREATING OUTPUT

You have reached the final part of ProShow 
production. Look for and click on the CREATE 
OUTPUT icon at the very top right of the ProShow 
screen.  A number of outputs will appear in a new 
window.   For now we are just interested in two of 
them,  PC Executable  and  DVD.

The PC Exec. File is what we use at the club.  This 
file is self running and will play on any computer.  
The DVD file will automatically place the show on 
a DVD.  This DVD will play on any consumer DVD 
player and on a computer.  If you are sending 
finished work to friends etc.  This is the one to use.

PC Executable File: (Note: This method can only be 
replayed on a computer).  Click on the CREATE 
OUTOUT button then on PC EXECUTABLE (lower 
left-hand corner). In the “Create Executable” 
window, cl ick on CREATE. In the SAVE 
EXECUTABLE FILE window, type in the File Name 
in the appropriate box, and click SAVE. 

DVD: (This method can be played on a computer or 
television). Click on the CREATE OUTPUT button 
on top of timeline window. In the “Create Output” 
window, click on DVD (upper left-hand corner). 
Next window, click OK. In the SAVE SHOW FILE 
window, type in the File Name in the appropriate 
box, and click SAVE. Insert a DVD in the DVD 
Writer. In the CREATE DVD window, click CREATE.

NOTE 1:  For both the Silent and Sight/Sound 
essays, all of the original files must be submitted 
along with the final show.  For this reason whenever 
files are made up or saved, always save them in the 
same image folder that was originally made up with 
your photos.  

When the fall and spring shows are made up, we 
have to link the individual shows together.  We 
work with the original images and music of the 
maker.  One timeline is produced with all the 
images and music of all the entries – it is one big 
show file.  Credits and other information are 
interwoven to produce the master show for public 
viewing.

NOTE 2: In all ProShow sub windows, there are 
many other controls that will serve you well and 
enhance the show.  For example in the sound 
section, we covered only the basic functions to get 
your show on the road.  It is now up to you to try all 
the other controls to see what they will do for you.  
My suggestion is to load about 15 images onto a 
timeline, practice all the stuff covered above and 
work it ad infinitum.  You will not break anything 
and when you close the ProShow session, you don’t 
even have to save your experiments.

Congratulations, you now have all the instructions 
necessary to produce an absolutely outstanding 
ProShow for our enjoyment.

  www.photodex.com

http://www.photoguild.ns.ca
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Wally Hayes

IT’S LOBSTER FISHING 
TIME IN SOUTHWESTERN 
NOVA SCOTIA

The name 'Total Chaos' on the boat in the 
foreground tells it all as fishermen in Lower 
West Pubnico prepare for 'dumping day' and 
the opening of the annual lobster season in 
Southwest Nova Scotia.
It's commonly called dumping day because at 
precisely 6 a.m. on the last Monday in 
November, thousands of lobster boats big and 
small fan out from hundreds of fishing villages 
to race each other for the prime spots to dump 
to set their traps. 
I visited Pubnico's Dennis Point wharf a couple 
of days before dumping  day and no matter in 
which direction I pointed my camera, I was 
greeted with a profusion and confusion of 

colour; boats and buoys; ropes and traps. Even 
many of the fisherman were dressed in 
fluorescent orange and yellow foul weather 
gear.
I thought I was seeing the result of an 
explosion of a hundred Christmas trees with 
colourful ornaments - (floats, ropes and traps) 
scattered in all directions.- some in confusing 
heaps and others lined up in military precision.
Spread over three docks were more than 80 
lobster boats each with an allotment of 375 
traps and an almost equal number of  coloured 
ropes and floats. Some boats were large 
enough to carry a full complement of traps, but 
for smaller ones, their excess traps and gear 

Before daylight on the last Monday in November thousands of fishing boats laden 
with lobster traps and gear stream out from fishing villages in Southwestern Nova 
Scotia for the opening day of the lobster fishing season.

Wally Hayes was there in December to capture it all on camera.
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was piled on the wharf to be loaded for a 
second trip to the lobster grounds, all on the 
same day. As I looked out at the widespread, 
colourful scene I thought of a Hollywood movie 
with the credits: "Filmed in Panavision . . . Color 
by Technicolor" I  did my unofficial math and 
figured I was looking at as many as 30,000 traps 
and enough rope to stretch the 700 kilometers 
from one end of Nova Scotia to the other, with a 
float or buoy every 1/10 of a kilometer along 
the way.

And that's just from Lower West Pubnico. 
Admittedly, this Acadian village probably has 
the largest concentration of lobster boats of any 
other fishing village in the western part of the 
province, but the amount of gear from all the 
ports that went into the water in the space of a 
few hours Monday morning staggers the 
imagination.

Preparation is months in the making - mending 
traps, coiling ropes, painting buoys and the 
myriad of other tasks that culminate in dumping 

day. It's one of the most important days of the 
year for thousands of fishermen whose 
livelihood depends on the sea.
In just an hour's time, this lobster boat (above) 
will race out of Yarmouth Harbour past Cape 
Forchu lighthouse (below) along with dozens 
of others.
In nearby Yarmouth, classes at the local schools 
are suspended for the day and students armed 
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with flashlights flock to the rocky shore of Cape 
Forchu beneath the Yarmouth Lighthouse to 
wave their lights as the parade of fishing boats 
races by in the black, pre dawn darkness. The 
fishermen respond by lighting the shore with 
floodlights from their boats.
(For the photographers among you, this picture 
was taken in almost total darkness, the only 
light being that of the fishing boats streaming 
by and one light each at the entrance of the 
lighthouse and in the light tower itself. The 
picture was taken with a time exposure of 30 
seconds and the light was provided by a 
1,000,000 candle power hand held spotlight 

flashed around the scene in a technique called 
'painting with light").

This article taken with permission from 
Wally Hayes’ Blog.  Please see many 
other wonderful works of Wally
Hayes by going to: 

http://www.novascotiablogs.com/whereiswally/ 

OR  just type Wally Hayes Blog in Google.
(Where is Wally)

SHOOTING AND STITCHING PANORAMIC 
PHOTOGRAPHS

by 
Mike McCarthy

Background
 According to Wikipedia’s Wiktionary, 
the word Panorama comes from the Greek 
words παν meaning “all” and όραμα meaning 
“sight” and is defined as “an unbroken view of 
an entire surrounding  area” or “a picture or 
series of pictures representing a continuous 
scene.”
 Even with the widest of lenses today, 
most cameras, digital or film, can only capture 
a portion of a scene that the human eye can 
see. There are cameras designed to photograph 
a 360 degree view of a scene, however, they 

are very specialized and incredibly expensive 
for us mere mortals, ranging into the tens of 
thousands of dollars in some cases. You may 
even recall the short lived “APS” or “Advanced 
Photo System” cameras that Kodak produced 
in the early 90’s that offered a panoramic print 
that was taken over two frames of a 24mm 
negative to produce a 4” x 12” print. This 
particular type of film was expensive to handle 
and died out rather rapidly as digital emerged 
onto the scene in the late 90’s.
 With today’s digital cameras, there are 
several ways to create a panoramic image. 
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Some digital point & shoot cameras, when set 
to “Pano Mode” simply reduce the effective 
sensor area to a band across the middle, 
virtually cropping the top and bottom to make 
the image “feel” like a panoramic image. Some 
more advanced digital cameras will allow a 
few images to be “stitched” in the camera to 
create a seamless high resolution image. This 
process only allows for a few images, usually 2 
or 3, due to the lack of processing power in the 
camera itself.
 Any camera, however, is capable of 
taking as many pictures of a scene as the 
photographer wants. It is with this particular 
technique that we combine all those images 
into one very large and very high resolution 
image on a computer using  specialized 
software.
 There are also several styles of 
panoramic photographs, each serving a specific 
purpose. The first and most easily recognizable 
is a wide print. I’m sure virtually all of us have 
a favorite landscape hanging in our homes or 
in a book somewhere. Many of these beautiful 
landscapes are a single image cropped away 
from the traditional 4x3 ratio negative to give 
more of a 16x9 wide image or the more 
cinematic 18x2 ratio image.  Once again, 
unfortunately, this style simply throws away 
information from the top and bottom of the 
image, although the end result can be visually 
quite dramatic and pleasing given sufficient 
resolution from the original film or digital 
negative.
 A less common style is the “virtual tour” 
panoramic image, which may be simply a 360° 
stitched image that allows the viewer to rotate 
around a single point to a complete spherical 
panorama that allows the viewer to not only 
rotate horizontally, but also to look up and 
down around a completely spherical 
representation of the “virtual” world. These 
types of panoramas usually encompass very 
large images and require specialized software 
to both create and view the end result. I 
created a virtual tour of a medical facility for a 
corporate client a couple of years ago that 
became a prominent part of their on-line 

marketing and sales. The tour encompassed 
nearly 1000 images stitched together using very 
specialized “virtual tour” software and 
included a complete walk through of the 
facility and individual 360° views of each 
room. This particular endeavor took over 200 
man-hours to complete.
 The style we will cover here is created 
by stitching several images together to create a 
single wide angle view on a slightly smaller 
scale. We will capture and stitch a single row 
of images, although these techniques can also 
be applied to capture several rows of images 
that can then be stitched vertically to create a 
“mega” panoramic image. I’ve seen some of 
these incredibly large images that include the 
equivalent of 18 GIGA-pixels.
Gear
 First , let ’s look at the required 
equipment. Everyone got your camera? You’re 
all set!
Actually, although you can create very good 
panoramic images handheld using  even a 
disposable camera, you will quickly find that a 
tripod and a camera mounted level will be 
greatly appreciated accessories. A camera 
mounted level is far superior to a tripod 
mounted level, especially if you have any type 
of ball head. The tripod levels will help level 
your tripod, however, you will often find that as 
your camera and lens rotate, slight variations in 
the camera’s horizon will require cropping of 
the final image. A camera mounted level 
usually mounts in the hot shoe and only costs a 
few dollars. You may also find that a remote 
shutter release helps eliminate any camera 
shake and helps the final images line up easier. 
A real “pro” panoramic shooter will tell you 
that you need a “Pano-Head” for your camera 
to ensure that you rotate around the “no-
Parallax” point of your camera and lens 
combination. Although this is true, unless 
you’re shooting for a client who is paying real 
money for your results, the final output without 
a specialized mount is usually good enough. 
Many stitching software can compensate for 
the parallax error introduced by using  a 
standard tripod and head. A quick internet 
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search of local camera store’s web sites shows 
several VR heads for sale ranging from $519 to 
$1710 not including the tripod. So, do you 
really need one? 
 Finally, you may also be told that a wide 
angle lens is required. At the end of the day, 
this is really not true at all. The only benefit to 
using a “wide-angle” lens is that you will have 
to take fewer images to get the detail and 
quality you are looking for. Personally, I use a 
10-20mm f4 lens (equivalent to 15-30mm on 
my particular 1.5x digital body) for most of my 
panoramas. If I’m not planning one and have 
left my 10-20mm at home, I simply use my 
18-50mm f2.8  (equivalent to 27-75mm) and 
take more images without a second thought. I 
actually sometimes will use the longer focal 
length to help compress the scene if shooting 
landscapes as well as to help eliminate the 
curved lines that will show up sometimes when 
using a very wide lens.
Techniques for Shooting
 As with any photographic style, there is 
really no wrong way to do it. Since 
photography is a very interpretive process and 
is intimately personal, the following techniques 
are simply suggestions and a little insight into 
how I shoot panoramas. They are certainly not 
exhaustive and not intended to be the only way 
to accomplish the end result. I also have a very 
specific workflow when shooting  and 
processing “panos.” Your workflow and specific 
software may vary.
Here are a couple of final considerations… 
Camera Orientation
 You can effectively shoot panoramic 
images with your camera in either horizontal 
(landscape) or vertical (portrait) position. My 
own personal preference is to hold or mount 
the camera in portrait position simply because 
it gives me the most pixels vertically and 
usually doesn’t require me to stitch rows of 
images together. If I am shooting a tall pano, of 
a building for example, I will use the landscape 
position for the same reason.

Exposure & Focus
 When shooting panos, it is incredibly 
important to select your point of rotation 
carefully. You should always shoot panos in full 
manual mode, if possible, or at least in 
Aperture Priority mode. This way, you can 
maintain a consistent DOF (Depth Of Field) 
and exposure throughout the entire image. 
When shooting a landscape, your camera will 
likely expose one portion (with the moon or 
sun) differently than other sections. This will 
create “banding” (strips of lighter or darker 
areas) in the final image and is visually 
unacceptable. It is best to select an aperture 
that will give you an appropriate (or widest) 
depth of field, depending on your subject 
material. From there, determine the best 
exposure and adjust the shutter speed as you 
take the individual images. I t is not 
recommended to adjust the ISO, which many 
cameras will do automatically, as higher levels 
of noise may be introduced in some images 
which again can introduce banding in the final 
image.
 Usually, I try to set up as close to the 
center of the final image as possible and 
manually select a focus point and exposure. I 
then set my camera on full manual and switch 
to manual focus as well.
Overlapping the Images
 You are now ready to capture the images 
for your panoramic masterpiece! Start by 
rotating your camera (assuming you’re on a 
tripod) to the left edge of the area you will be 
shooting and capture the first image. Review 
your capture on the camera’s screen to ensure 
it is exposed and focused as you expect. If it 
isn’t, now is the time to correct any variations.  
I have also included bracketing each image as 
part of my workflow, just to make sure I have a 
wide range of images to work with and select 
from. At some point, I have every intention to 
compose HDR panoramic images. It’s just a 
matter of finding the time to assemble them… 
Bracketing - in case you aren’t familiar with the 
term - means that you take several exposures of 
the same composition, usually 1 overexposed 
and 1 under exposed. My camera allows me to 
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select to capture up to 5 images up to 2 stops 
apart with a single press of the shutter. Since it 
doesn’t require any additional work to capture 
the images – only lots of memory cards and 
hard disk space – I take advantage of the 
feature.
 Once you have the exposure and focus 
where you want, I usually put my hand in front 
of the lens and capture a single dark image that 
later indicates to me that this is the start of my 
pano. I also take another when finished a 
particular sequence. I do this for one main 
reason. Many of my panoramic images 
encompass several dozen shots plus the test 
images. So it can be difficult to remember 

which should actually be the start image once I 
get them loaded onto the computer later. I then 
proceed to capture the first image of the series. 
I then carefully rotate the camera to the next 
image position and repeat the process for as 
many images as I need to complete the view I 
want to represent. Each image should overlap 
by at least 30% of the previous one. Many 
software programs can stitch an image that is 
only overlapped by 5-10% today, but I’d still 
rather make sure that I have every shot I need 
and assume I won’t be able to go back and 
shoot the images again if I miss something. 
Memory is cheap and I’ve never been accused 
of not taking enough shots. 
Your end result should look like these:

Moving to the Computer
 I’ll assume you can transfer the images 
from your camera to your computer. I usually 
create a folder based on the date and scene 
plus the word “Pano” so that I know the 
purpose of the images 6 months down the 
road.
 Again, I use several common pieces of 
software for a typical panoramic work. When 
stitching panoramas, your computing hardware 
does become important. My software includes 
Adobe Photoshop Lightroom 2.6 (at the time of 
writing this) and Adobe Photoshop CS4 
(v11.0.1). Both versions are 64-bit running on 
Microsoft Vista Business 64-bit operating 
system. I’m not a Mac user, but I’m pretty sure 
that OS-X Snow Leopard is fully 64-bit, while 
many older versions are not. I use the 64-bit 
version of my OS and tools simply because of 
the speed and memory benefits. I use a dual 
core processor because it can do two things at 
once. I also use an Adobe certified video card 
with 1GB of video memory to speed up the 
display processing. 

 Finally, the 32-bit versions of Windows 
(and many older Macs) only allow access to 
approximately 3.27GB of system memory. Even 
if you have more, Windows simply doesn’t 
know it’s there because it cannot count that 
high. A 64-bit operating system can support up 
to about 4 terabytes of RAM in theory, although 
I haven’t seen a 1TB memory chip yet… 
Panoramic images can get very large, very 
quickly. If you run out of memory and need to 
use the “scratch disk” to work on smaller 
chunks of the image at a time (your OS does 
this automatically) you will end up pulling 
your hair out while you wait for the computer 
to catch up. You can usually tell this is 
happening when your computer hard disk 
drive starts growling and response slows down 
dramatically. My computer has 8GB of RAM 
and a dedicated 250GB scratch disk that is 
used for nothing else but to help speed things 
up. More is always better!
 There are many software tools that will 
accomplish the same end result, but for the 

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca


Photographic Guild of Nova Scotia www.photoguild.ns.ca

- 19 -

purposes of this article, these are the ones I will cover. Your workflow and steps will quite likely 
vary.
 My images are loaded onto the computer; I see a screen like this in Lightroom:

Then simply right click and select “Edit in - 
and “Merge to Panorama in Photoshop...” 
from the menu as seen here.”

 One of the reasons I use Lightroom is because of the tight and simple integration to 
Photoshop to ease the automation process of creating panos. Within any module in Lightroom, 
using the filmstrip near the bottom of the screen, simply click on the first image in the sequence, 
hold the shift key and then click on the last image, like this:

 You can also accomplish this without Lightroom by saving the images you want to merge into 
a single folder and selecting “File” -> “Automate” -> “Photomerge…” from within Photoshop.
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 At this point, you will be presented with a “Photomerge…” screen like this:

So, at this point I can crop my image using the crop tool and setting the aspect ratio to 16x9 like 
this:

 I like to work as “non-destructively” as possible, just in case I decide to change something 
down the road – remember memory and hard drives are cheap! So, for the next step, I create a 
merged version if the layered document by pressing [Control]+[Alt]+[Shift]+[E] which creates a new 
layer in Photoshop of all the visible layers and places it at the top of the layer palette.
I then add any sharpening, burning, dodging, levels, etc. to this merged image and then select “File” 
-> “Save” which writes a PSD layered document to the same folder as the original files and updates 
Lightroom so I can then export as a JPEG, TIFF or a print from within Lightroom.

For the most part, it is alright to accept 
the default settings and click OK. 
Photoshop will take a few minutes – 
depending on how many images and 
how large the source images are – to 
create a blended multi-layer version of 
your new panoramic image. In my 
case, it looks like this:
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AIR SHOW PHOTOGRAPHY

by
Doug Lahey

 From an early age I have had an interest in 
military aircraft, from building  models to watching 
planes flying  across the sky. While doing photography 
for the Shearwater Air Show I have had a number of 
flights in different military aircraft. Flying  with the 
Snowbirds in 1996 was one of the highlights of my life. 
There is something  about military aircraft and the 
incredible skill of the pilots that is thrilling to all of us.

...continued.

Here’s the final image:

 Although Photoshop CS3 and previous 
included the ability to create merged 
panoramic photos, the alignment algorithms 
were dramatically improved in CS4. This 
allows you to create better seamless 
panoramas in far less time. The steps given 
here will work in previous versions of 

Photoshop although they may change slightly 
and will definitely take longer to process. 
Personally, I do very little in Photoshop except 
for the actual merging of the images. All my 
retouching and editing are accomplished in 
Lightroom… But that’s another story… ;)
If you have any questions, please do not 
hesitate to contact me by e-mail or simply 
chat with me at one of the guild meetings. As 
my wife will tell you (as she rolls her eyes), I 
love to talk about my photography! ;)
All images are ©  2009 by Mike McCarthy and may not 
be duplicated or used in any manner without express 
written permission except as required to publish the 
Photographic Guild of Nova Scotia’s newsletter in 
either print or digital versions for limited distribution 
to members and affiliates only. All other rights are 
reserved.

F-18 and moon
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Practice:
 Like all successful photography it 
requires practice. You can practice a few days 
before the Air Show opens. Go to the airport 
on Thursday or Friday when the aircraft are 
arriving. There is always a back road near the 
airport that will give you close access to the 
incoming aircraft. This is when the arriving 
pilots really ham it up for the media.
 Camera and lens:
 Other than a camera and a long lens 
you don’t require any special equipment other 
than a folding chair. You’re not going to need a 
camera with all the bells and whistles. To 
capture an image with impact you will require 
a 200mm to 300mm lens, anything smaller just 
isn’t large enough. Your lens should have an 
aperture of 2.8 to 5.6, but it shouldn’t be any 
slower.

 
 

Tripod or a monopod
A tripod or a monopod is not practical in a 
crowd. They are also a hindrance during the air 
show as the aircraft are making an overhead 
pass, a roll, a loop at about 300 to 500 miles 
per hour.
 The right exposure:
 Getting the right exposure is impossible 
if you allow your camera to choose all the 
settings off the sky and aircraft. I always carry 
half of an 18% gray card. I take a spot meter 
reading off the gray card. Then I set my camera 
to full manual mode using what ever settings 
the gray card tells me. However, as the day 
goes on you have to keep checking your 
exposure as the sun is moving and clouds may 
start moving in or out. If you don’t have an 
18% gray card you can check the exposure by 
taking a meter reading off the grass and or a 
reading of half grass and half sky.
 Composition:
 There isn’t much that I can say about 
composition that you don’t already know, but 
I’ll give it a try. For a photo with impact you 
should almost fill the frame with the aircraft. 
Frame the shot so there’s plenty of space in 
front of the aircraft and the plane appears to 
have room to fly forward. In today’s digital 
world you can always crop or add some sky in 
front of the aircraft. It is much more pleasing to 
take the photo when the plane is facing 
towards you.
 Location:
 The best location to capture the Air 
Show is a matter of preference. Some 
photographers like to be at either end of the 
runway, because the planes take off and land 
or they often bank just before landing.  
However, you can’t always be in the correct 
location at an air show for the best photos. I try 
to get as close to the runway as I can at “show 
center”.  The VIP “show center” area is a better 
location as there are fewer spectators viewing 
the show.
:

Snowbirds over 
Halifax

 
and 

Snowbird fly pass
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 Photographic angles for impact
 There are a number of angles to 
photograph a flying aircraft that will give 
your images impact. One of the most 
dynamic views comes when the aircraft is 
banking, showing the top and side of the 
aircraft and the pilot. At this angle it appears 
that you are flying along in another aircraft.

Safety regulations do not permit aircraft to fly 
toward the crowd. However, these rules don’t 
always apply to the Snowbirds. They fly straight 
toward the crowd, then they bank to the left, right 
and straight up as they approach center stage.

The "knife-edge" pass:  love this one but it takes 
practice… practice… practice.
The "knife-edge" pass is one of the hardest photos 
to capture. During the knife edge pass there are 
two planes flying toward each other, one plane 
flying from the right and the other from the left on 
a collision course. I like to pan from left to right 
and just before I think they are about to meet, 
cross or crash, I press the shutter and keep 
following through. The plane you are panning 
with should be sharp and the other plane will be 
out of focus. If you’re real lucky you have two 
planes in the same frame. The image of the Blue 
Angels has the two planes. This year at the 
Yarmouth Air Show the Snowbirds didn’t perform 
the "knife-edge" pass

 
Snowbirds in White

Buffalo flying low

Snowbirds Flying towards you

Canada’s Snowbirds fly-pass

Blue Angels Pass
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Airshow and Spectators

Helicopter and Propellor Movement
 Slower shutter speeds will show 
some movement in the propellers, a little 
blurred motion. If the propellers are 
stopped on a flying aircraft your shutter  
speed is set too high. You will have to 
practice with different shutter speeds on 
your camera.  Camera shutter speeds that 
show blurred motion on a helicopter may 

not work for a faster propeller driven aircraft.
You don’t always have to use a long lens. The day 
of the Air Show, arrive as early as possible when 
there are fewer people around the aircraft. Look 
for different angles and backgrounds around the 
static ground display. During the air show you 
should take a few photos of the spectators 
viewing the show. Kids are always interesting to 
photograph, face painting, playing on the army 
equipment etc.  The static aircraft (parked planes) 
allows you the opportunity to take close-ups of 
the plane and people viewing them. 
 The 2010 International Air Show will be 
back in Halifax at the Stanfield International 
Airport. 

Happy flying! See you at stage center 
in September.

Propeller  - Wing Walker

Snowbirds Too Close

Snowbirds Pass

Propeller Movement
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Air Show and Spectators

Air Show Face Painting

Air Show Spectator Kids

F-86 Sabre Jet parked

Static aircraft

Spectators viewing helicopter

Static Jet
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Viewing a Tank
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I also like to take pictures of nose art

Static Kid

Static Plane

F-86 & A-10- Heritage 
P51 at Shearwater Out of The Clouds

The drop off Canso PBY-5A
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CREATIVE DIGITAL IMAGING
by Stephen Patterson

The new age o f d ig i ta l imag ing has brought for th many creat ive 

oppor tun i t ie s , a long wi th controvers ies and s t ress fu l encounters 
for the f ine ar t photographer.  A f ter many years o f t rad i t iona l 
darkroom exper ience , I was enthra l led wi th the f lex ib i l i ty and 

creat ive potent ia l and , a t the same t ime, somewhat apprehens ive 
about the new poss ib i l i t i e s that the computer could o f fer to the 

v i sua l ar t i s t .  I t i s a reve la t ion to be separated f rom t r ips to the 
darkroom, wi th i t s chemica l s and smel l s , park ing expenses , and 
renta l fees .  I can now s i t comfor tab ly in my smal l o f f ice , co f fee 

by my s ide , and work qu ie t ly wi th my computer, scanner, and 
pr in ter, produc ing pr in t s that are , in my op in ion , abso lute ly 

super ior  to  the  ones  I  made in  the  t rad i t iona l  lab .

 There are many topics that could be 
addressed with regard to using Photoshop, 
and a single article would never cover even a 
small percentage of them all.  I generally use 
Photoshop to create fine art prints that 
reasonably match my original slides, with 
s o m e c o l o u r c o r r e c t i o n , c o n t r a s t 
adjustments, and preparation for making a 
final print on some media of my choice, such 
as watercolour paper, lustre paper, or matt 
inkjet paper.  The array of available paper 
from various manufacturers with which to 
print on is enormous and growing monthly.

In this article, I will cover some of the more 
creative aspects of my photography that I 
enjoy doing exclusively with Photoshop.  
They are fairly straightforward and not very 

difficult to get the hang of, and they only require 
some experimentation on the part of the artist once 
he or she has learned some of the basic techniques.  
Please note that while I will attempt to explain 
things as simply as possible, a fundamental 
knowledge of Photoshop’s tools would be very 
helpful.  With some practice, you will have these 
techniques down pat and will develop your own 
angle on using some of them to your own personal 
tastes.  There are many variables to these methods 
of image manipulation.

NOVEMBER FOREST

 Although certain kinds of multiple 
exposures, especially those with wind movement 
or zoom swirls, cannot be done with Photoshop, 
you can certainly open up many new doors to 
exploration in this realm.
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1. I began by opening a straight photograph of 
N o v e m b e r F o r e s t , d u p l i c a t e d i t 
(Image>Duplicate) and sent the original back 
to the folder for safe keeping.

2. I then created a duplicate of this copy, called 
it Copy 2, and pulled it to the side.  This gave 
me two copies of the same image in the 
Photoshop screen.

3.Using the Move tool (located on the top right 
of the Tools pallet- keyboard shortcut V), I 

dragged a layer off of “Copy 2 onto the first 
copy by left clicking and dragging.  This 
created two layers of the same image.

4.Next, I set the opacity of the layers to around 
50, and went to Select All, and then 
Edit>Transform>Distort.  This allowed me to 
move the top layer around, just like I would 
if I was slightly moving the camera while 
making multiple exposures.  I could also 
stretch the image as much as I wanted, 

WAVE GALLERY
This is a straight conversion of a 
colour image to black and white 
using Image>Mode>Greyscale.  This 
was an image that I felt made a great 
black and white print, perhaps nicer 
than it’s colour sibling.

I applied some basic contrast and 
tonal adjustments after converting it.

http://www.photoguild.ns.ca
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1. For this image, I used two layers to create an 
Orton effect, following the same procedures as 
with Wave Gallery, but omitting the step for 
conversion to black and white.  I then flattened 
the image.

2. Next. I desaturated the house by separating it 
from the foliage in the foreground with the Lasso 
tool and feathering the selection by around 25.  
I then dropped the saturation in Hue/Saturation 
(Image>Adjustments>Hue/Saturation) until it 
was almost monochromatic.

3. I then inversed my selection (Select>Inverse) 
and slightly warmed up the grasses with the 
colour balance.

ALIEN ENCOUNTER

1. I started with a vertical photo of an old 
chrome bumper with some interesting 
reflections.  I overexposed it by going to 
Image>Adjustments>Brightness/Contrast, and 
moving the Brightness slider to the right, to 
around 70.  

2. I duplicated the image and flipped the 
duplicate horizontally (Image>Rotate 
Canvas>Flip Canvas Horizontal).

3. Now I had two copies of the same image, but 
one was reversed.  I pulled the reversed image 
over on top of the other with the Move tool (top 
right in the Tools pallet), to create another layer.  
I made sure that I had Snap set (View>Snap), so 
that the overlying image would easily snap into 
place, perfectly registered about the other.  I 
then opened the Layers pallet and set the Blend 
Mode to Multiply.  Next, I flattened the image 
(Layer>Flatten Image).

4.  The last step was to add the eyes, which I 
borrowed from a photograph of a blue-footed 

booby.  I 
c i r c l e d 
t h e e y e 
with the 
L a s s o 
t o o l , 
c o p i e d 
a n d 
p a s t e d 

OLD HOUSE

All photos: 
Stephen Scott 
Patterson
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(Ctrl C/Ctrl V for PC, or Command C/
Command for Mac), then dragged the eye onto 
Alien Encounter, and carefully placed it top 
left.  I copied the eye again (Ctrl C for PC, or 
Command C for Mac) and, this time, flipped it 
horizontally (Edit>Transform>Flip Horizontal)., 
and positioned that eye to the right, exactly 
opposite the eye in the top left I used the 
eraser tool to carefully erase any extraneous 
detail from around the eye layers so that they 
blend into the picture better, and then brought 
the opacity of each eye layer down a bit, so 
they would blend nicely into the photograph.  
Some burning, dodging, and fine tuning, and 
then the final image.

Reprinted from Photo Life Magazine with permission 
from the author, Stephen Scott Patterson.

One photo out of focus is a mistake, ten 
photos out of focus are an experiment, 
one hundred photos out of focus is a 
style. -author unknown

You can find an excellent article on 
diffraction limits at this URL:

http://www.cambridge in colour.com/
tutorials/diffraction-photography.htm.

Here is an entire site for learning the fine 
points of photo technology.

http://www.cambridge in colour.com/
tutorials.htm

Photos: John Wm. Webb

Apple Orchard in Winter

Ice On RoofLook Off in Winter
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Annual Nova Scotia 
Bird Society
Competition

T h i s i s a n a n n u a l 
competition open only to 

members of the Photographic 
Guild of Nova Scotia. . 

1.Up to two colour transparencies, or digital 
images, may be submit ted by each 
photographer. See Section 11.2 for digital file 
specifications.

2.The image of a wild bird must be have been 
photographed in Nova Scotia. The bird must 
not have been caged or otherwise restrained 
when photographed.

3.Species winning in previous years are not 
eligible for this trophy.

4. Images must not have been submitted in any 
other Nova Scotia Bird Society Competition.

5. Images will be judged on technical 
excellence, but also on originality, scientific 
interest, aesthetic appeal and artistic 
composition. At least one of the judges will 
be a member of the Nova Scotia Bird Society. 
There will be one winner declared with no 
runners-up.

6.The Nova Scotia Bird Society may copy all of 
the entries and use them for educational 
purposes, publish them in its newsletter, and 
display them at meetings of the Society, with 
credit being given to the photographer. 
Copyright remains with the photographer.

7.A brief account should be enclosed with each 
entry, giving the circumstances in which each 
photograph was obtained, technical details 
(focal length, exposure, make of camera and 
film), locality, and date. The photographer's 
name and address should also appear on 
each slide mount or be included in the File 
Info for each digital image.

8.Digital Entrants must provide with their entry 
a CD, labelled with their name and address, 
containing both a high resolution file and a 
low resolution file of their image(s). 
a) The high resolution file should be at the 

maximum resolution supported by your 

digital camera or scanner. ie a 6MP 
camera will be approximately 3000x2000 
pixels. The dpi setting does not matter as 
this will be determined when the image is 
used for printing. Colour space should be 
sRGB or AdobeRGB 98 and the ICC 
profile embedded when the file is saved. 
(The maximum resolution should not 
exceed 4096 x 2730 (11MP) pixels as this 
is the maximum resolution used by a film 
recorder.) 

b) A low resolution version of the file should 
also be included for use with a digital 
projector. The image should be a 
maximum of 1024 x768 pixels (Width x 
Height). The dpi setting does not matter 
when an image is projected. Colour space 
should be converted to sRGB and the ICC 
profile embedded when the file is saved.

9.Entries are submitted at the photographer's 
risk.

10.Entry of an image in this competition 
indicates agreement by the maker to abide by 
these rules.

Appendix Sect 11.2

File Format and Labeling
Each digital image should be submitted in the 
following format:
1  Images must be submitted as JPEGs. Mac 

users must add .jpg or .jpeg extension.
2  Use maximum image quality. (12 in 

Photoshop)
 3 Convert files to sRGB colour space if 

required.
4 Images must be in the proper orientation for 

viewing when projected.
5. The maximum image size is 1024 x 768, 

(width x height). Vertical images can have 
a maximum height of 768 pixels tall.

6. File name must include category, last name, 
first initial and name of image. Category 
coded as above i.e. P (Pictorial) or S (Slide 
set). Slide sets must use sequential 
numbering in the file name. Do not use 
spaces or illegal characters (/,*,\,etc)
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CPAWS NS Launches Annual
Photo Contest and Blue Jean Gala!

CPAWS NS is launching  an annual photo 
contest and blue jean gala to celebrate the 
beauty of Nova Scotia. There are picture 
perfect moments across our province and 
CPAWS NS wants to see your photography 
skills put to work.

The photo contest runs from December 1, 
2009 to February 28, 2010. All amateur 
photographers are welcomed to participate 
in the contest. For contest details, see

http://cpawsns.org/campaigns/education/
photocontest.php

Christina MacLeod

Annual Nova Scotia Bird Society
Competition (continued)

File Name Examples:

P-SteeperP_Golden-Rainbow-Saint-John.jpg
C-DelucaR_Golden-Boat.jpeg

Slide Set Example

S-GhizG_01-Artic-Wolf-on-the-Run.jpeg
S-GhizG_02-Bobcat.jpeg
S-GhizG_03-Artic-Hare.jpeg
S-GhizG_04-Buffalo-at-Dawn

NS Bird Trophy Winners

1989  Common Tern   Pat Wall
1990  Red-Tailed Hawk   Fred Greene
1991  Great Black-Backed Gull  Pat Wall
1992  Common Loon   Lorris Keizer
1993  Flicker    Lorris Keizer
1994  Piliated Woodpecker  Lorris Keizer
1995  Bald Eagle    Lorris Keizer
1996  Osprey    Lorris Keizer
1997  Pheasant    Pat Wall
1998  Junco     Lorris Keizer
1999  Robin     Lorris Keizer
2000  Yellow Warbler   Lorris Keizer
2001  Evening Grosbeak   Lorris Keizer
2002  American Goldfinch  Lorris Keizer
2003  Magnolia Warbler  Lorris Keizer
2004  Immature Saw Whet owls Lorris Keizer
2005 White Throated Warbler Lorris Keizer
2006  Great Blue Heron  Lorris Keizer
2007    Cedar Waxwing  Lorris Keizer
2008 Palm Warbler   Jen Fried
2009 Red-breasted Nuthatch Ken Renton

WARNING TO PHOTOGRAPHERS

http://www.guardian.co.uk/
environment/2010/jan/20/wolf-wildlife-
photographer-award-stripped#

A R T I C L E S s h o u l d b e 
submitted in one of the 
following formats: Microsoft 
Word, Macintosh Pages, or 
plain text.

Images should be attached 
to the email message, not 
embedded in the article body.

How to Submit Material To The Bluenose Focus

All members are invited and encouraged to submit 
material to the Newsletter:  Images, Field trip 
information, how to do something, upcoming events, 
articles, letter to the Editor, what our members have 
been up  to – i.e., Special trip, held an art exhibition, 
photo tours, photo seminars, bought a new camera,  
EVERYONE PLEASE SEND ME SOMETHING !!! 
plover@ns.sympatico.ca (Etta Parker). 
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FIELD TRIP TO CLARKE 
HEAD, PARRSBORO 
WITH GEOLOGIST 
ROB FENSOME, MAY 
8TH, 2010 

Because of tide constraints, the AGS Field Trip 
this year will not be until 8th May, when we 
will visit Clarke Head near Parrsboro.  Low 
tide will be in the afternoon, so tentative plans 
will be to meet in Parrsboro around lunchtime 
--- but final details will be announced on the 
website closer to the time, or by contacting 
Rob Fensome after 1st April.

Clarke Head is accessible via stairs to the 
beach at the Glooscap Campground just east 
of Parrsboro.  We will walk east along the 
beach on the falling tide.  The going underfoot 
is variable, but bouldery in places --- so please 
expect a modicum of beach hopping, and 
bring sturdy footwear to match.

The geology is scientifically fascinating and 
visually interesting and colourful.  

The sea views, as ever along this shoreline, are 
distracting --- islands, sea stacks, 

distant cliffs and the occasional bald eagle to 
steal the show.

As we walk eastward, the cliffs are low and 
consist of the Triassic-age (~200-million-year-
old) Blomidon Formation, topped by the North 
Mountain Basalt.  Those who have been to Five 
Islands and Cape Blomidon will recognize 
these units.  But after about 10-15 minutes of 
walking, the geology changes and a major 
fault brings more ancient Carboniferous (~330-
million-year-old) rocks to the surface.  What 
caused the crust to break here.  To find out 
what geologists think happened, you’ll have to 
come on the field trip.  And if you come, you’ll 
also see the amazing jumble of rocks that 
make up the cliffs as we walk further east for 
the next hour or two, before returning in good 
time to avoid the rising tide.
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Summary- CAPA Interclub 
Fall Results

Hello all, this competition year has brought 
about a number of changes for CAPA 
competitions including a new digital 
category. Images submitted in “Altered 
Reality” must be heavily manipulated and 
obviously creatively enhanced. This includes 
use of composites, creative filters, etc. To 
encourage the use of new work in all of its 
competitions, this year CAPA has included a 
time limitation of 24 months prior to the 
competition deadline when images should 
have been taken. So for the Spring 
competitions, images shot for the digital 
theme as well as “altered reality” should have 
been taken after Jan 20, 2008. For the Nature, 
Pictorial and Print competitions, images 
should have been shot after Mar 20, 2008.
The Guild is doing quite well so far in the 
new CAPA competition system.  In the Digital 
Division we were tied for fourth place out of 
26 clubs with 153 points in the Open 
Category and earned an Honour Award 
certificate. A mere three points behind the 
first place club. In Digital Nature we received 
117 points and were tied for seventh place 
out of 25 clubs, missing a Club Honour 
Award by three points. In the Print Division, 
the club was fifth out of 8  clubs with 131 
points and received an Honour Award 
Certificate. 
In the Film Division, submissions have 
dropped off dramatically. We were first out of  
two clubs competing in the Open category 
and the only club to compete in Nature. 

CAPA REPORT by Joyce Chew

OPEN DIGITAL - HOSTED BY ST. THOMAS PHOTOGUILD

ENTRY PHOTOGRAPHER SCORE

Stewiacke Tree Colin Campbell 25

Snorkeling at the Slush Cup Peter Steeper 24

Theaud Dawn T. Egan 27

Pleione formosana Joyce S.K. Chew 25

Oak Leaf and Ice Bubbles Vicki Gaul 26

Beautiful Male Woodduck on 
Fall Water

Marion Boyer 26

TOTAL SCORE 153

Congratulations to Eugene Mio who had the top 
scoring images in both categories!

Good luck to everyone in the upcoming 
competitions and keep those great images coming!

NATURE DIGITAL HOSTED BY RA PHOTO CLUB

ENTRY PHOTOGRAPHER SCORE

Snowy White Egret in the wind Marg Nolen 21

Wentworth Falls Mike McCarthy 20

Mono Lake California 1 John Wm Webb 16

Caught a Locust Marion Boyer 20

Maritime Ringlet Vicki Gaul 20

Palm Warbler in Reeds Paul Boyer 20

TOTAL SCORE 117
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NATURE FILM HOSTED BY KIMBERLEY CAMERA CLUB

ENTRY PHOTOGRAPHER SCORE AWARDS

Evening Light Algarve Keith Vaughan 19 THIRD

Lichen on Roks Joyce S.K. Chew 17

Scabiosa columbaria Keith Vaughan 18

Colours of Fall Eugene Mio 20 SECOND

Reindeer Lichen Joyce S.K. Chew 17

Rocks Ashore Eugene Mio 22 FIRST

TOTAL SCORE 113

PRINT HOSTED BY WINDSOR PHOTO GUILD

ENTRY PHOTOGRAPHER SCORE

Scratch My Back Jen Fried 22

Staring Wolf Mike McCarthy 19

Wet Leaves Hubert Boudreau 22

Open to the Sun Charles Plant 22

Greek Fisherman Keith Vaughan 21

Male Bluebird on Spring Branch Marion Boyer 25

TOTAL SCORE 131

Celebrated Canadian photographer, 
Freeman Patterson, once said 'the 
camera looks both ways.' This was an 
insight into human nature that he most 
certainly learned from years of 
experience at his craft. His comment 
expresses his belief that there is a clear 
artistic connection between what takes 
place before the camera and what takes 
place behind it. The art of the 
photograph owes as much to one as to 
the other. Images photographed are as 
much a statement about the 
photographer as they are of the subject. 
Patterson believes the pictures we take 
are a documentation of our own 
personal history at the time the picture 
was taken. Through the camera, we see 
only what 'the eye' records at that 
particular moment. The photograph 
reflects our ability to be present to a 
particular scene, person, or thing and 
our personal emotional response to it."

Partners in Healing Pg, 32 Par. 2, a 
Handbook by Beverly Anne 
Musgrave and John R. Bickle

OPEN FILM HOSTED BY PHOTO FREDERICTON

ENTRY PHOTOGRAPHER SCORE AWARDS

Traditional Algarve Fishing Boat Keith Vaughan 22

Winter at the Frog Pond Hubert Boudreau 19

Friedrihswerdersche Kirche Joyce S.K. Chew 24 SECOND

ALGARVE SEASCAPE Keith Vaughan 23

Kurort Rathen Joyce S.K. Chew 21

Wonders of Bryce Canyon Eugene Mio 25 FIRST

TOTAL SCORE 134
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PSA REPORT  

January 2010
 by Mike McCarthy

2009 was a particularly busy season with a 
number of new rules and division chair people 
and although we are more than half way through 
the 2009-2010 season, some of the interclub 
competitions are just gearing up.
The biggest of the new rules this year is the “un-
mounted print” rule as well as the new categories 
for interclub prints. Now that prints can be sent 
without mounts, I have seen a drastic reduction in 
postage cost - nearly 50%! Many of the division 
chairs are also now accepting  PayPal electronic 
payments for return postage, which again 
significantly reduces costs. For example, if return 
postage from the US is $9 (USD) the post office 
charges $4.95 plus tax for the money order fee. So 
the total cost for return postage becomes around 
$18 with exchange and taxes added into the 
picture. There are still a couple of hold outs, but 
I’m sure by next season all divisions will be using 
electronic payment methods.
Also, there is still no division chair for the Nature 
– Slide division, so I will be bringing  slides back to 
those who previously had them selected to go 
away. If you haven’t received your slides, please e-
mail me or see me at a meeting.

I am hopeful that next year we will host a couple 
of interclub competitions at PGNS. We had to 
reschedule the PJ judging because the images 
could not be gathered in time for the scheduled 
judging and our program is very busy for the 
available dates to re-judge. 
The Adobe sponsored PSA competition should be 
exciting and I will post a link to the winners as 
soon as the international judging takes place.
. The individual scores are included with the prints 
themselves and I will update everyone as soon as 
they are received.

Standings are not presently 
posted. I will update as soon as 
they are available.

ELECTRONIC IMAGE (EID) DECEMBER JUDGING BY 
SCHLAUMBURG AREA PHOTOGRAPHIC CLUB

ENTRY PHOTOGRAPHER SCORE

Painted Daisies Jen Fried 9

A Moment In Time Mike McCarthy 10

Winter Pasture Ken Renton 10

Hanging With Robbie Peter Steeper 11

White Sand Dunes NW 
Afterglow

Keith Vaughan 8

Castle Rock No. 1 John Wm. Webb 8

No Standings available yet

PRINTS OCT. JUDGING BY THE WEST CUMBRIA PHOTO GROUP (UK)

Please note:  I have not yet received the individual scores   
only the list of award winning prints.

ENTRY PHOTOGRAPHER SCORE AWARDS

Dogwood (LC) Jen Fried 23 SECOND

Hurricane Bill at Peggy’s 
Cove

Peter Steeper 23 HM

Currently tied for 2nd Place out of 7 clubs, 9 points out of 1st
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PJ DECEMBER JUDGING OKLAHOMA CAMERA CLUB

ENTRY PHOTOGRAPHER SCORE

Canyonlands Cliffhanger Tanya Elson 10

Cape Spear Dawn Jen Fried 10

Wipeout George Mitchell 11

Repelling Laslo Podor 9

Tour de Bloc Women’s Final Peter Steeper 11

K4 Men 1000m”B” Final Keith Vaughan 8

PGNS current Standing 11th out of 23 clubs

LARGE MONO

ENTRY PHOTOGRAPHER SCORE AWARDS

Cape Breton Porch Ken Renton 25 FIRST

Wentworth Falls Mike McCarthy 21 HM

Currently 1st place out of 6 clubs, ahead of 2nd place by 2 points

SMALL COLOUR  NO AWARDS - PRESENTLY TIED FOR 3RD 
OUT OF  6 CLUBS, 13 POINTS OUT OF 1ST.

Small Mono  No Awards  Currently 4th out of 5 clubs, 14 points 
out of 1st.

PRINTS DECEMBER JUDGING BY THE SAGUARO CAMERA CLUB

LARGE COLOUR

ENTRY PHOTOGRAPHER SCORE AWARDS

Great White Egret Ken Renton 22

Canter Jen Fried 23

Straw Hat and Veil Keith Vaughan 25 THIRD

Currently in 3rd place out of 11 clubs, 12 points out of 1st

PJ DECEMBER JUDGING OKLAHOMA CAMERA CLUB

ENTRY (Small Colour) PHOTOGRAPHER SCORE

Venice Canal Colin Campbell 20

Wild Iris Ken Renton 20

Musa Ornata Blossom George Mitchell 21

Print 3 Peter Steeper 21

Currently tied for 5th out of 11 clubs, 19 points out of 
1st

PJ DECEMBER JUDGING OKLAHOMA CAMERA CLUB

ENTRY (Large Mono) PHOTOGRAPHER SCORE

Florence from San Miniato Colin Campbell 20

Hallstatt Monochrome Keith Vaughan 22

Cara B&W Mike McCarthy 22

Tuscan Curves Dean Hirtle 21

Currently tied for 3rd place out of 12 clubs, ahead of 11 points 
from 1st

NATURE NOVEMBER JUDGING BY THE WEST CUMBRIA 
PHOTO GROUP (UK)

ENTRY PHOTOGRAPHER SCORE

Male Warbler with insect Marian Boyer 11

Hairy Woodpecker Jen Fried 12

Peregrine Falcon Feeding Marg Nolen 9

Moth Laying Egg Laszlo Podor 9

Nuthatch Ken Renton 12 HM

Landing 2 Joseph Szostak 12 HM

Currently tied for 2nd out of 22 clubs in group B, 12 points 
out of 1st.

CREATIVE NOVEMBER JUDGING BY:  NOT AVAILABLE

ENTRY PHOTOGRAPHER SCORE

The Mar in Halifax 
Harbour

Marian Boyer 12 HM

The Coffee Shop Teunis Obdam 5

Midnight Ride Elio Dolente 7

3Bikes & Yellow 
Tulips

Keith Vaughan 7

One Too Many Clive Elson 7

Eye of the Storm Marg Nolen 8

Standings not currently posted.  Will update as they are 
available.

SMALL MONO

ENTRY PHOTOGRAPHER SCORE

Remira Jen Fried 21

Maritime Boat Ken Renton 23  HM

Springtime Light Dean Hirtle 18

Currently 5th out of 11 clubs, 49 points out of 1st
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PHOTOGUILD SCORES 2009/10
Updated: 22/01/2010

Total Total Total Adjusted Score Total Score Average

Number Slides- Images Top 75 Images All Images Score Distinction 

# Name Surname Prints Digital POY Points

1 Ken Renton 20 70 90 877 1021 11.12 550
2 Marian Boyer 14 65 79 858 894 11.03 388.5
3 Jen Fried 20 59 79 848 883 10.86 622
4 Mike McCarthy 20 68 88 832 949 10.50 398.5
5 Colin Campbell 16 62 78 826 852 10.60 511.5
6 Laszlo Podor 14 63 77 805 823 10.43 355.5
7 George Mitchell 15 58 73 781 781 10.41 114
8 Keith Vaughan 12 57 69 768 768 10.80 375
9 Bob Kerr 6 68 74 762 762 10.00 239

10 Joyce Chew 0 69 69 741 741 10.43 220.5
11 Dean Hirtle 20 53 73 737 737 9.84 153.5
12 Carolyne Renton 2 66 68 736 736 10.44 191.5
13 Hubert Boudreau 15 62 77 728 743 9.45 294
14 Marg Nolen 0 60 60 672 672 10.78 404
15 Esther Theriault 0 70 70 669 669 9.56 147
16 Tanya Elson 0 57 57 648 648 11.00 204.5
17 Clive Elson 0 56 56 631 631 10.82 231
18 Charles Plant 13 41 54 559 559 10.06 90.5
19 John Wm. Webb 2 48 50 536 536 10.30 265
20 Mona Ghiz 0 53 53 520 520 9.81 52.5
21 Viki Gaul 0 48 48 517 517 10.77 85.5
22 N. E. Davis 0 40 40 450 450 10.75 302.5
23 Peter Steeper 14 23 37 401 401 10.84 145.5
24 Nancy Johnston 0 34 34 375 375 10.32 108.5
25 Eugene Mio 4 29 33 363 363 10.33 218.5
26 Teunis Obdam 0 31 31 323 323 10.42 197.5
27 Joseph Szostak 0 29 29 291 291 10.03 169.5
28 Merv Kumar Misir 0 25 25 245 245 9.80 114
29 Rocky Yao 2 20 22 222 222 10.09 41
30 Paul Boyer 0 20 20 203 203 10.15 41.5
31 Yau-Sun Tong 0 14 14 186 186 11.36 347.5
32 Cherie McCarthy 0 14 14 133 133 9.50 7
33 Roy Doucette 0 8 8 74 74 9.25 9
34 Jim Marshall 2 5 7 72 72 10.29 14.5
35 Hugh McKervil 0 6 6 66 66 11.00 32.5
36 Wayne Garland 0 6 6 59 59 9.83 225
37 Ron Whitaker 0 4 4 38 38 9.50 0
38 Tony Egan 0 3 3 33 33 11.00 4.5
39 Cliff Sanderson 0 0 0 24 24 0.00 49
40 Danny Sharp 0 2 2 23 23 11.50 0
41 Normajean Stevens 0 2 2 20 20 10.00 61

Legend:
Names in RED identify new members.
 "P of Y" = "Photographer of the Year"
In 2009/10, POY will be based on the best 75 images plus slide essays.
Total and Adjusted scores include all digital images, slides, prints, as well as slide essays.

Silent Slide essay is scored out of 30. Sight and Sound essay is scored out of 70.

http://www.photoguild.ns.ca
http://www.photoguild.ns.ca
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We are pleased to announce a call for entries for 
The EPSON International Pano Awards, dedicated 
to the art of panoramic photography.

We would love to see Photographic Guild of Nova 
Scotia members entering the competition...and 
doing well!

Entries close 30th April.

If you have any further queries, please don't 
hesitate to contact me.

Kind regards,
David Evans, Curator

Become a fan on Facebook!

The EPSON International Pano Awards

www.thepanoawards.com

Carson- Mosher Photographic 
and Atlantic Photo give Guild 
Members a 10% discount on 
many accessories, plus the 
PGNS receives 5% from your 
purchases.

http://www.facebook.com/#/pages/The-EPSON-International-Pano-Awards/259310013359?ref=nf
http://www.facebook.com/#/pages/The-EPSON-International-Pano-Awards/259310013359?ref=nf
http://www.thepanoawards.com/
http://www.thepanoawards.com/
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Doug Lahey

Doug Lahey

Doug Lahey

Doug Lahey Doug Lahey

Ralph Rosere Carol Morrison

Carol Morrison Carol Morrison Carol Morrison

WINTER IMAGES TAKEN BY 
PHOTOGRAPHIC GUILD OF NOVA SCOTIA 

MEMBERS

Doug Lahey
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Waterfall and Spruce
John Wm. Webb

Stream In Winter
Elio Dolente

Wet Snow
Bob Deluca

My First Darkside
John Wm. Webb

My Neighbour’s Driveway
John Wm. Webb

My Lawn Bicycle
John Wm. Webb

Snow River
John Wm. Webb

Peggy’s Cove
Ken Renton

Winter Scene
Esther Thirault
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Steven Norris

Panorama - Purcell’s Cove
Carol Morrison

Steven NorrisSteven Norris

Steven Norris
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Jen Fried Jen Fried Jen Fried

Fred Joyce

Fred JoyceFred Joyce

Fred Joyce

Fred Joyce

Fred Joyce

Fred Joyce

Fred Joyce
Fred Joyce

Fred Joyce
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Yau Sun Tong

PHOTOGRAPHIC GUILD OF NOVA SCOTIA WEBSITE

The PGNS website is maintained by Peter Steeper and Chris MacDonald. Visit the website for 
the latest information on the Guild, 
updated program, image galleries, and 
photography links.

BLUENOSE FOCUS
January 2010

Editing & Layout by
 Etta M. Parker.


